CIS ADMIN: A BASIC USERS’ GUIDE

This guide is for faculty administrative staff who are responsible for editing data in CIS and troubleshooting issues for faculty users. It does not replace the online documentation, but rather acts as a condensed version pointing you to the detailed information.

Download this guide at: http://cis.uts.edu.au/documentation/cis/access.html#guide

If you are a subject coordinator, you should instead download Subject Outlines: A Basic Users’ Guide.

CONTENTS

1. Introduction
   1.1. Curriculum Information System (CIS)
      1.1.1. Course Information
      1.1.2. Subject Outlines
   1.2. System requirements
   1.3. Documentation
2. Registration and access
   3. Finding data
      3.1. Course Information
         3.1.1 View tab
      3.2. Subject Outlines
         3.2.1 Fields
4. Editing data
   4.1. Compulsory data
      4.1.1. UTS website: study areas (CI groups)
      4.1.2. UTS website: breadcrumb display
   4.2. Assessment tasks
   4.3. Data entry tips
      4.3.1. System timeout
      4.3.2. Pasting text from Word
      4.3.3. Long links and URLs in the data
   4.4. System icons
5. Subject outline PDFs
   5.1. Troubleshooting
      5.1.1. Font has shrunk
      5.1.2. Need to delete a PDF
      5.1.3. User can’t access their subject
      5.1.4. Data missing
      5.1.5. Subject learning objectives (SLOs)
      5.1.6. Course intended learning outcomes (CILOs)
      5.1.7. Criteria linkage tables (CLTs)
6. Change request (workflow)
   6.1. Basic procedures: responder
   6.2. Basic procedures: approver
   6.3. Troubleshooting
      6.3.1. Reset the change request
      6.3.2. Final approval buttons: which should you choose?
   6.4. Workflow process diagram
7. Graduate attributes
   7.1. Definitions
      7.1.1. CAGAs
      7.1.2. CGAs
      7.1.3. CILOs
      7.1.4. Parent study package
      7.1.5. SLOs
      7.1.6. CLTs
   7.2. Consequences of making changes
      7.2.1. CAGAs
      7.2.2. CGAs
      7.2.3. CILOs
      7.2.4. Parent study package
      7.2.5. SLOs
      7.2.6. CLTs
   7.3. Display of GAs in subject outline PDFs
   7.4. GA reports
8. Publishing data
   8.1. UTS: Handbook
   8.2. CASS data -> CIS
   8.3. CIS data -> UTS website
1. INTRODUCTION

- Log in: https://cis-admin.uts.edu.au

UTS course and subject data is stored in one authoritative source, made up of two systems, the Curriculum and Student System (CASS), and the Curriculum Information System (CIS):

- **CASS** stores high-level data: e.g. course name, codes, credit-point values, rules of completion, program templates, requisites, etc. Changes to CASS data need to be requested via UTS: ServiceConnect, Academic Programs Office, Curriculum.

- **CIS** stores descriptive data: e.g. why study this course, career options, subject descriptions, course area information, etc. Changes to most CIS data can be made by you directly in CIS. Changes to CIS data that you can’t access, need to be requested via UTS: ServiceConnect, Academic Programs Office, CIS or via email.

1.1. Curriculum Information System (CIS)

CIS comprises two components: Course Information (the orange tab) and Subject Outlines (the green tab).

If you’re an Admin in both Course Information (CI) and Subject Outlines (SO), by default after login you go to the CI search screen.

If you’re an Admin in Subject Outlines (SO) only, after login you go to the SO search screen.
1.1.1. Course Information

Course Information (CI) is where CIS course, subject (excluding subject assessment task and program fields which are only editable in SO), major, sub-major, choice block, stream and course area data is stored, visible and editable.

Additionally, CI is where the Change Request (created in SO) workflow is responded to and approved (if your faculty uses the inbuilt workflow approval process).

1.1.2. Subject Outlines

Subject Outlines (SO) holds a sub-set of CI subject fields, plus assessment tasks, criteria linkage tables (CLTs) and the week-by-week program fields not editable in CI.

SO is where subject coordinators edit their subject data and also where they can request changes to fields they do not have edit access to, via the Change Request tab (if your faculty uses the inbuilt workflow approval process). Subject Outline PDFs are generated via SO.

As CIS is the approved authoritative source of subject data, all Subject Outline PDFs should be generated from it.

1.2. System requirements

Ensure that your internet browser is compatible. CIS supports the following:

- Internet Explorer 9 and above
- Firefox ESR 17 and above
- Safari 6 and above
- Chrome

Ensure you have Adobe Reader and the latest Adobe Flash Player installed.

1.3. Documentation

Detailed information is available online about the functions and usage of CIS. It is accessible via the ‘Documentation’ links in the left navigation of the system under the ‘Go to’ heading (note: where the link goes changes depending on whether you are in CI or SO, but the linking text is always ‘Documentation’).

- Course Information Documentation: http://cis.uts.edu.au/documentation/cis

To assist with finding information in the documentation, you can also check the A–Z Index in CI and the A–Z Index in SO. For help with navigating the documentation, see the Site map in CI and the Site map in SO.
2. **REGISTRATION AND ACCESS**

Users need to be registered and should be familiar with the documentation to access CIS. There is an online and a PDF registration form, available via the CI documentation and SO documentation. Either can be used.

Before submitting a registration form, users **must** check with their faculty administrator (i.e. you) to ensure that they have completed the form correctly and that the access they are requesting is appropriate.

When users are given access to the system, they are assigned to a role which determines what they can do in the system. CI and SO have two main categories of access ('Edit' and 'View'), with add-on administrative, graduate attribute and workflow privileges, as required.

The documentation has full details on:

- what level of access a user needs and how to complete the rego form: CI/SO
- what the role titles mean
- adding new users in **Course Information** or **Subject Outlines**
- amending a user’s access in Subject Outlines (e.g. adding a subject to a subject coordinator’s access).
3. FINDING DATA

3.1. Course Information

If you are an Admin Editor (CI), most data can be edited via CI. The only data not editable via CI are subject assessment tasks (including the CLTs) and the week-by-week program, which can only be edited via SO.

Find the data you want to update/check via the Search tab (opens automatically at login). From the Search tab you can search for any ‘type’ of data that you have access to (i.e. if you only have access to subject data, you’ll only see the search options for subjects). The search criteria available (including the advanced search options) changes based on the ‘type’ of data you’ve chosen. The types of data held in CI are:

- courses
- subjects
- majors, sub-majors, choice blocks, streams (you can add a description paragraph that will appear above the CASS completion requirements in the UTS handbook)
- course areas (i.e. the information found under ‘Information for students’, ‘Undergraduate course information’ and ‘Postgraduate course information’ in the UTS handbook).

Choose the search criteria and click the [Search] button. You’ll be taken to the Result tab. You can return to the search criteria and refine or expand it and search again by clicking the Search tab.

On the Result tab, click the [View] button to go to the View tab or the [Edit] button to go to the Edit tab. The View tab shows CASS and CIS data held for the course. The Edit tab only shows CIS data.

3.1.1 View tab

CASS data is displayed on the View tab in a few places:

- **Above the rule at the top of the view screen**: course code, course name, status, version, award(s), UAC codes, CRICOS codes, CSP status, credit points, EFTSL, qualification, level, liability category, owning/collaborating faculty, course area(s) (i.e. keywords 1/2)
- **Admission requirements**: a mix of CASS and CIS data makes up the admission requirements; the CASS data are:
  - **standard admission requirements**: these statements are based on the qualification level of the course (e.g. Bachelor’s Degree) in CASS, and reflects the UTS Rules; the statements for each qualification level are held in CIS and automatically map to each course; the statements are only editable by CIS Admins
  - **visa requirements**: this standard statement is held in CIS and is automatically displayed against any
course that is offered to international students, i.e. it is dependent on the ‘Liability Category’ held against the study package in CASS; the statement is only editable by CIS Admins

- **English language requirements**: these statements state the English proficiency requirement for international students or local applicants with international qualifications; the ELR code is set up in CASS (at the direction of UTSI); the statements are held in CIS and the CASS code automatically maps to the relevant statement; the data is not displayed if the course is not offered in English or the course is offered offshore only; the statements are only editable by CIS Admins

- **Course completion requirements**: this data is drawn from the course’s Study Package Structure in CASS

- **Course program 2**: this data is drawn from the Study Package templates in CASS.

### 3.1.2. Fields

The **Fields** section in the CI documentation provides information on the required format of every CIS field and where you edit the data, what publications use each field, and examples of specific publications and the fields they use and the order the fields are used in.

**Help**: Each field has a question mark icon (❓). Hover over this to see a pop-up box containing formatting, word count, content and style guidelines.

#### 3.2. Subject Outlines

If you are an Admin Editor (SO), most of the subject data that appears in Subject Outline PDFs can be edited via SO. The only subject data not editable via SO are graduate attributes (i.e. GAs, CILOs, SLOs, parent SPKs), which can only be edited in CI, via the relevant Graduate Attributes tab.

**Find** the subject you want to update/check via the **Search** tab (opens automatically when you go to the Subject Outlines section).

Choose the search criteria and click the **[Search]** button to retrieve the list of subjects. You’ll be provided with a list of results.

![Search](image)

**Note**: When subject coordinators go to the **Search** tab, they do not need to search as the entire list of subjects assigned to them (i.e. the ones they can edit) is already displayed.

To edit the subject data, click on the instance button, e.g. ‘Default’. You’ll be taken to the subject’s **Edit Main** tab. Most subjects only have a **[Default]** button, but if you’ve created additional instances of the subject, e.g. ‘Block’, ‘Distance’, ‘Short’, ‘Special’, buttons for these instances appear here also; if all additional instance options have not yet been created, there is a **[New instance]** button beside the **[Default]** button. See the documentation for full details on instances and when you may want to create additional ones.
3.2.1 Fields

The Fields section in the SO documentation provides information on the required format of the fields editable by subject coordinators. The complete list of subject fields used in the Subject Outline PDF and where each field can be updated is available in the CI documentation.

*Help:* Each field has a question mark icon (?). Hover over this to see a pop-up box containing formatting, word count, content and style guidelines.
4. EDITING DATA

In CI, the editable fields are on the Edit and Graduate Attributes tabs.

In SO, the editable fields are on the Edit Main, Assessment Tasks and Program tabs.

The way data is edited is the same in CI as SO. Any field you can edit turns yellow when you hover your mouse over it.

If there is no data stored in a field, ‘[no content]’ is displayed under the heading.

To edit data, click in the yellow area. The field is now active (i.e. you can edit it). An active field is indicated by a blue banner and border around the field (all other fields will have a grey banner and border).

Once a field is active, a text editor tool bar (very similar to Microsoft Word styling buttons) will appear at the top of the screen, just under the tabs.

Use it in the same way you’d use Word, e.g. to change several paragraphs into a list, highlight them and click the bulleted or numbered list button (  ).

The third option along (  ) is to paste as plain text. Always use this button if you are pasting in data copied from another source document. This ensures that hidden formatting, such as exists in Word, is stripped out and will not interfere with formatting in CIS.

If you want to view the HTML coding, you can click the Source button, but unless you’re familiar with HTML coding it’s probably safer to use the text editor button to style your data.

Click [Save] to retain your changes.

Note: This tool bar will always appear in the same place at the top of the screen, even if the field you’re editing is at the bottom of the screen.
All fields that are part of the Subject Outline PDF are all displayed on the Edit Main tab.

You can edit any field that is flagged with a green +/- icon (i.e. ☑ or ☐) in the top right-hand corner of the text box and turns yellow when you hover your mouse over it (note: this feature is currently in SO only, not CI).

If you don’t have edit access to a field, it will be flagged with a red +/- icon (i.e. ☐ or ☑) and won’t turn yellow when you hover over it. There will also be a green change request icon (i.e. ☑) beside the field name.

Subject coordinators can request changes to these fields via the Change Request tab in the subject’s Default instance (if your faculty uses the Workflow function), or via your faculty’s existing approval processes.

See the documentation for details of the fields that subject coordinators can edit and the fields that make up the Subject Outline PDF.

### 4.1. Compulsory data

**Compulsory data** is indicated by red asterisks beside the relevant field names on the Edit tab. Additionally a warning message will appear at the top of the Edit tab if compulsory data is missing. Courses will only be made Active in CASS if all compulsory CIS data has been provided (some exceptions apply for exit-only courses where not all compulsory data is required).

#### 4.1.1. UTS website: study areas (CI groups)

For courses to appear in study areas on the UTS website, they need to be added to a CI group. Courses can belong to one or more groups, and the groups can be owned by any course area (although you should first check with the other course area if you want to add your course to one of their groups). Only APO CIS staff can add courses to groups and generate a report showing what courses are assigned to each group owned by the faculty.

#### 4.1.2. UTS website: breadcrumb display

A ‘breadcrumb’ is a type of online navigation that shows the user’s location on a website. To control the breadcrumb display for courses on the UTS website, you need to choose a primary group from the group(s) that the course is assigned to. The ‘breadcrumb’ is displayed at the top of the course information.
The ‘Primary group: breadcrumb display’ is edited on the course’s Edit tab.

Choose the primary group from the study areas (i.e. the groups the course is assigned to) listed on the dropdown list. If there are no options on the dropdown list, the course has not yet been assigned to a CI group. Contact APO CIS to have it added.

**Example:** The Bachelor of Communication (Creative Writing) Bachelor of Laws is assigned to two groups in CI: ‘Undergraduate Law Programs’, and ‘Writing’. This means the course will be displayed in the following study areas on the UTS website: ‘Undergraduate Law Programs’, and ‘Writing’.

The primary breadcrumb display in CI is set as ‘Undergraduate Law Programs’. This means that the breadcrumb display, irrespective of which study area you take to get to the course on the UTS website, will always be:

UTS > Future students > Law > Undergraduate Law Programs > Bachelor of Communication (Creative Writing) Bachelor of Laws

### 4.2. Assessment tasks

Assessment tasks are managed in SO via the Assessment Tasks tab. The complete set of assessment tasks is listed at ‘Manage tasks’. Difference instances of the subject can use a different subset of tasks, if required. To determine the sub-set to use in the subject outline PDF, the task must be ticked on via the ‘Display’ column on the ‘Manage tasks’ screen.

Only approved tasks appear on the Assessment Tasks tab. If new tasks have been requested via the Change Request tab, they will only appear on the Assessment Tasks tab / Edit tasks (and become editable by subject coordinators), after they have been approved via workflow change request.

### 4.3. Data entry tips

Data entry tips are available in CI and SO. These have been collected based on the most common user-issues reported and are updated as required. Below are brief summaries of the most common issues; see the documentation for full details on how to fix any problems.

#### 4.3.1. System timeout

The system will timeout after 25 minutes of inactivity. Users will lose all data changes if they have not clicked the [Save] button before this occurs. You will get an onscreen warning five minutes before timeout.

#### 4.3.2. Pasting text from Word

Microsoft Word documents contain lots of hidden characters and tags that will not reproduce correctly within the database and are very likely to cause coding problems. Therefore, if you are pasting text from MS Word into the database, you should either:

- paste it in using the [Paste as plain text] button in the text editor tool bar, or
- save the file you’re working from as ‘Text only’ before you copy and paste the data directly into the field.
4.3.3. Long links and URLs in the data

If the text in the Subject Outline PDF has dramatically reduced in size, it's probably because long URLs have been included in one of the fields that make up the PDF. Long links and URLs (i.e. website addresses) can cause layout problems in the PDF because, as there are no spaces in the link, the PDF generator doesn’t know where to break the line. The result of this can be that the text of the whole document is shrunk so the link can fit onto the one line unbroken.

4.4. System icons

Several icons are used throughout CIS to indicate various functions and data states. See the documentation (CI and SO) for details about the icons, where you will see them (if at all) and what it means when you do see them.
5. **SUBJECT OUTLINE PDFS**

Subject outline PDFs are generated via the Preview/Generate PDF tab in SO. Only approved data will appear in the PDF. This means that any data requiring approval by APO CIS will not appear in the outline until it is approved, nor will any data requiring approval via workflow change request.

The Subject table in the CI documentation shows what fields require APO CIS approval (col. 4). Additionally, the edit icon (✍️) will appear beside all fields that have edits needing APO CIS approval, and there will be a warning on the ‘Insert page breaks’ screen when you generate the PDF, advising you that there are unapproved amendments.

Amendments are usually approved within the day, but for anything urgent, just email an APO CIS admin.

### 5.1 Troubleshooting

#### 5.1.1. Font has shrunk

If the text in the Subject Outline PDF has dramatically reduced in size, it’s probably because long URLs have been included in one of the fields that make up the PDF. Long links and URLs (e.g. website addresses, links to PDFs) can cause layout problems in the PDF because, as there are no spaces in the link, the PDF generator doesn’t know where to break the line. The result of this can be that the text of the whole document is shrunk so the link can fit onto the one line unbroken.

#### 5.1.2. Need to delete a PDF

If a user has created a PDF that they shouldn’t have (e.g. they’ve created a Spring PDF instead of a Summer PDF), it can be deleted, but only by an APO CIS admin. Email to request this.

#### 5.1.3. User can’t access their subject

Users are sometimes unable to access a subject they are the subject coordinator of. There are a few possible reasons for this:

- **Does the user have access to the system?** Check their access via: SO/Admin/Users/Search user ID. To be able to edit a subject via SO, they need a minimum level of ‘Editor (SO)’ access. If they don’t have access, they need to complete a registration form.
- **Has the subject been assigned to the user?** Check their access via: SO/Admin/Users/Search user ID/Current subjects. If the subject isn’t on the user’s list, add it via the ‘Add subjects’ function.

#### 5.1.4. Data missing

If data that’s been added by a user is missing from the generated PDF, they are a few possible reasons for this:

- The **data is yet to be approved** (either via APO CIS or workflow); check if the edit icon (✍️) is beside the field name.
- The added **data was rejected during workflow** (check the log at CI/subject code/Workflow/Log) or APO CIS approval (check the log at CI/subject code/Log).
- The **data is part of an assessment task that is not ticked on** (check via SO/subject code/Assessment Tasks/Manage tasks).

#### 5.1.5. Subject learning objectives (SLOs)

SLOs are displayed in the PDF under the ‘Subject objectives’ heading.

- **Heading and SLOs not displayed:** check that there are SLOs stored for the subject (via CI/subject code/Graduate Attributes/Learning objectives).
- **There is no lead-in sentence:** add a lead-in sentence (via CI/course area/'SLO lead-in sentence’ field) (note: the lead-in sentence will appear above the list of SLOs in every subject outline across the course area).
5.1.6. Course intended learning outcomes (CILOs)

Linked CILOs (via CLTs) are displayed after the list of SLOs under the ‘Subject objectives’ heading. If no CILOs are displayed, check that:

- the subject has a parent study package assigned to it (via CI/subject code/Graduate Attributes/Parent study package), and
- the parent study package has CILOs set up (via CI/course code/Graduate Attributes/Intended learning outcomes), and
- there is a lead-in sentence (via CI/course area/’CILO lead-in sentence’ field (note: the lead-in sentence will appear above the list of CILOs in every subject outline across the course area), and
- one or more CILOs are linked in one or more of the subject’s assessment tasks’ CLTs (via SO/subject code/Assessment Tasks/Edit #/’Criteria linkages’ field).

5.1.7. Criteria linkage tables (CLTs)

The criteria linkages table (CLT) is where you indicate which of the subject’s SLOs and parent study package (course or major) CILOs (if any) are addressed by the assessment task. CLTs are updated via: SO/subject code/Assessment Tasks/Edit #/’Criteria linkages’ field.

Display

There are two ways to display CLTs in a subject outline PDF:

- an APO CIS admin can change the CLT setting for an entire course area; this will mean that, where data exists, every assessment task, in every subject will display the CLT, or
- a faculty admin (e.g. you, if you have access) can manually change the CLT setting for individual assessment tasks, as needed (via SO/Assessment Tasks/Edit #/’Criteria linkage setting’).

Missing data

If the CILO dropdown is blank, check that:

- the subject has a parent study package assigned to it (via CI/subject code/Graduate Attributes/Parent study package), and
- the parent study package has CILOs set up (via CI/course code/Graduate Attributes/Intended learning outcomes).

If the SLO dropdown is blank, check that there are SLOs stored for the subject (via CI/subject code/Graduate Attributes/Learning objectives).

Note: Changes made by a subject coordinator to SLOs via the Change Request tab are not available on the SLO dropdown in the CLT until they have been approved via the workflow process.

Warning message

A warning message will appear above the CLT on the assessment task edit screen if any changes have been made to related SLOs or CILOs.

See section 7. Graduate Attributes for further details.
6. CHANGE REQUEST (WORKFLOW)

The inbuilt workflow approval process enables a subject coordinator (the ‘creator’) to request a change (‘create a change request’) to a subject field that he or she doesn’t have edit access to. This change request is checked by an authorised person in the faculty (the ‘responder’, e.g. the faulty admin person who makes CIS changes) who recommends the change for approval or rejection and then forwards (‘transfers’) it to the final authority in the faculty (the ‘approver’, e.g. the associate dean) for final approval or rejection.

Note: Not all faculties use the inbuilt workflow approval process.

See the downloadable workflow process diagram for a flowchart of the complete process and the frequently asked questions section for answers to the most common queries.

6.1. Basic procedures: responder

Once a subject coordinator (i.e. the workflow change request ‘creator’) clicks the [Submit] button in SO, users in the faculty with workflow ‘responder’ privileges receive an email telling them to that a new change request needs assessment.

1. Go to CI/Notifications/Workflow.
2. Click the [Edit] button beside the subject you want to assess.
3. Assign the change request to yourself by clicking the [Assign to me] button near the top of the screen (a red flag alert icon (i.e. �谧️) will then appear beside every field that requires your assessment). Note: if the change request has been transferred to you, it will already be assigned to you.
4. Assess each field individually: for every field with a red flag, click in the field’s ‘Change request’ text box, check the changes and make any required amendments (i.e. fix typos, grammar, data in the wrong field, etc.).

Help: Each field has a question mark icon (❓). Hover over this to see a pop-up box containing formatting, word count, content and style guidelines.

Tip: To see the difference between the old data and the new data, click the ‘Show differences’ icon (i.e. 📞) beside the field name.

Then in each field, click one of the three available assessment buttons:
- [Recommend for approval]: this means the change is ok, it has been checked for grammar and typos and is recommended for approval (the red flag will disappear)
- [Recommend for rejection]: this means the change is not ok and is recommended for rejection (the red flag will disappear)
- [Note]: this means that you can’t decide if the change is ok or not; it’s been checked for grammar and typos and noted (another ‘responder’ or the ‘approver’ needs to make the decision to approve/ reject the change) (the red flag will change to a red pin, i.e. 📅)

5. You can generate a draft PDF, including the changes requested, via: CI/subject code/Workflow/PDF (note: subject coordinators can also generate a draft PDF via SO/subject code/Change Request/Preview PDF)
6. Once there are no more red flags displayed, transfer the change request to an approver (via CI/subject code/Workflow/Transfer). At this point, the workflow ‘state’ will be either ‘Ready for approval’ or ‘Pre-approval complete’.

Full details are available in the documentaton.
6.2. Basic procedures: approver

When a change request is transferred to you (i.e. the ‘approver’) by a ‘responder’, you will receive an email.

1. Go to CI/Notifications/Workflow.
2. Click the [Edit] button beside the subject you want to approve.
3. Check the workflow state (indicated at the top of the screen under the subject name):
   - **Ready for approval**: this means that the change request has been fully assessed by one or more responders and they have recommended or rejected each field. Check each field to ensure you agree with the responder’s assessment and override any you don’t agree with by clicking the relevant button (i.e. either [Recommend for approval] / [Recommend for rejection]).
   - **Pre-approval complete**: this means that the change request has been fully assessed by one or more responders and they have recommended, rejected or noted each field. Noted fields are fields that the ‘responder’ can’t make a decision on, i.e. they can’t decide whether to recommend or reject them. Noted fields are indicated on screen with a red pin icon (i.e. ). Therefore, in addition to checking the recommended and rejected fields, you also need to assess the noted field and decide whether to recommend or reject it and click the relevant button (i.e. either [Recommend for approval] / [Recommend for rejection]), at which point the red pin will disappear.

4. You can generate a draft PDF, including the changes requested, via: CI/subject code/Workflow/PDF
5. Once you have checked the assessment of each field in the change request package, you can then action/reject the package as a whole by clicking one of two buttons located at the bottom of the screen:
   - **[Action change request package]**: click this button if you think the assessment of every field (i.e. either ‘recommended’ or ‘rejected’) in the change request package is correct.
   - **[Reject change request package]**: click this button if you think the assessment of every field (i.e. either ‘recommended’ or ‘rejected’) in the change request package is not correct.

**Note:** When the [Action ...] button is clicked, changes that have been ‘rejected’ will disappear from the system; changes that have been ‘recommended’ will be held in the system.

**Note:** When the [Reject ...] button is clicked, changes that have been ‘rejected’ AND changes that have been ‘recommended’ will be PERMANENTLY LOST from the system.

- There is NO UNDO function once either of the buttons has been clicked.
- These buttons only appear when all fields have been fully assessed, i.e. the workflow ‘state’ is ‘Ready for approval’; they are not displayed if there are fields that still have a preliminary assessment of ‘Noted’, i.e. there is a red pin icon displayed beside any field name.

Full details are available in the documentation.
### 6.3. Troubleshooting

See also the [Frequently asked questions](#) section in the documentation.

#### 6.3.1. Reset the change request

The change request workflow can be reset to a previous state or cancelled completely at anytime throughout the process. The role you have and the change request state determine which of the reset/cancel buttons are accessible:

Note: The System Admin role is only assigned to staff within the central APO; email us with any requests.

<table>
<thead>
<tr>
<th>State</th>
<th>Button</th>
<th>What does it do?</th>
<th>Role/user who can action button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request in preparation</td>
<td>Cancel</td>
<td>• Cancels the change request. All amendments are lost.</td>
<td>• The user who created the change request</td>
</tr>
<tr>
<td></td>
<td>Reset</td>
<td>• Resets and closes the change request. All amendments are lost.</td>
<td>• Responder</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Used by the subject coordinator if they change their mind about wanting the package of requested</td>
<td>• Approver</td>
</tr>
<tr>
<td></td>
<td></td>
<td>changes.</td>
<td>• System Admin</td>
</tr>
<tr>
<td>Request submitted</td>
<td>Reset to</td>
<td>• Resets the change request to the ‘Request in preparation’ state and reassigns it to the creator.</td>
<td>• Responder</td>
</tr>
<tr>
<td></td>
<td>preparation</td>
<td>Amendments made up until the request was submitted are retained.</td>
<td>• System Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use if you want to send the change request back to the subject coordinator because they need to make</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>some amendments to existing or additional fields.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reset</td>
<td>• Resets and closes the change request. All amendments are lost.</td>
<td>• System Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use if the subject coordinator isn’t available to cancel the change request or if a new subject</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>coordinator takes over the subject and wants to create their own change request.</td>
<td></td>
</tr>
<tr>
<td>Fields being assessed</td>
<td>Reset to</td>
<td>• Resets the change request to the ‘Request submitted’ state. Amendments made up until the request was</td>
<td>• System Admin</td>
</tr>
<tr>
<td></td>
<td>preparation</td>
<td>submitted and any changes made by the responder during the ‘Fields being assessed’ state are retained.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use if you want the subject to be unassigned and then picked up by another responder. (or you could</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>just transfer the change request to another responder without resetting it)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reset</td>
<td>• Resets and closes the change request. All amendments are lost.</td>
<td>• System Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use if a new subject coordinator takes over the subject and wants to create their own change</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>request.</td>
<td></td>
</tr>
</tbody>
</table>
### State | Button | What does it do? Why would you use it? | Role/user who can action button
--- | --- | --- | ---
Pre-approval complete | Reset to submitted | • Resets the change request to the ‘Request submitted’ state. Amendments made up until the request was submitted and any changes made by the responder during the ‘Fields being assessed’ state and the responder/approver during the ‘Pre-approval complete’ state are retained. • Use if you want the subject to be unassigned and then picked up by another responder. | System Admin

Ready for approval | Reset to submitted | • Resets the change request to the ‘Request submitted’ state. Amendments made up until the request was submitted and any changes made by the responder during the ‘Fields being assessed’ state and the responder/approver during the ‘Pre-approval complete’ state and the approver during the ‘Ready for approval’ state are retained. • Use if you want the subject to be unassigned and then picked up by another responder. | System Admin

Reset | Reset | • Resets and closes the change request. All amendments are lost. • Use if a new subject coordinator takes over the subject and wants to create their own change request. | System Admin

### 6.3.2. Transfer a change request

You can transfer a workflow change request via CI/Notifications/subject code/Workflow/Transfer. Transferring the change request keeps any amendments already made.

The ‘state’ that the change is in determines what names appear on the transfer dropdown list:

- **Request in preparation**: any user with create privileges, i.e. ‘C’ in their role title
- **Request submitted/Fields being assessed**: any user with with respond privileges, i.e. ‘R’ in their role title
- **Pre-approval complete**: any user with with respond or approve privileges, i.e. ‘R’ or ‘A’ in their role title
- **Ready for approval**: any user with with approve privileges, i.e. ‘A’ in their role title

### 6.3.3. Final approval buttons: which should you choose?

The final approval buttons action or reject the change request package as a whole.

- If you think that the assessment of every field (i.e. either ‘recommended’ or ‘rejected’) in the change request package is correct, click the **[Action change request package]** button. When this button is clicked, changes that have been ‘rejected’ will disappear from the system; changes that have been ‘recommended’ will be held in the system.
- If you think that the assessment of every field (i.e. either ‘recommended’ or ‘rejected’) in the change request package is not correct, click the **[Reject change request package]** button. When this button is clicked, changes that have been ‘rejected’ AND changes that have been ‘recommended’ will be permanently lost from the system.
6.3.4. **Missing approval buttons**

The package approve/reject buttons are only available (at the bottom of the screen) when the change request package is in **Ready for approval** state, i.e. (i) all fields have been assessed as either ‘recommended’ or ‘rejected’, and (ii) the user has a workflow ‘approver’ role, and (iii) the change request is assigned to them.

If there are red flags or red pins beside any fields, then the package approve/reject buttons will not be visible.

6.3.5. **Validation errors: submit change request**

If the change request includes changes to any of the assessment task ‘Weight’ fields, the new data is validated before the change request submission can be completed.

**Weight validation** occurs only on the tasks that are ticked on at SO/subject code/Assessment Tasks/Manage Tasks/ ‘Display’ column.

- If data in one or more weight fields has been amended that causes the total to not equal 100, then the change request submission process is cancelled and a pop-up screen alerts the user to the problem. The user needs to recheck all assessment task weight fields, amend as required and then submit the change request again.
- Any new task set up in the change request is, by default, not yet ticked on and its weight will therefore not be included in the validation calculation. If there is a new task in the change request, the user needs to go to SO/subject code/Assessment Tasks/Manage Tasks and tick the checkbox beside the relevant new task(s) in the ‘Display’ column; return to SO/subject code/Change Request/Fields and then resubmit the change request.

6.3.6 **Log of changes**

Every change made during workflow is logged. This means you can see which users have made edits to or approved fields during the change request and when these changes were made. The log is available via: CI/subject code/Workflow/Log.

Click the ‘view’ link to see the data that has been added at the change request step.
6.4 Workflow process diagram

Download the workflow process diagram (PDF A3).
7. GRADUATE ATTRIBUTES

By storing graduate attributes in CIS, it is possible to link assessment task criteria to the development of graduate attributes. Once this has been done, you can report on what proportions of the assessment are targeted at developing specific CILOs and SLOs. If an imbalance is revealed, it can then be corrected.

7.1. Definitions

Detailed definitions are provided in the documentation as well as diagrams providing examples of four models of assigning graduate attributes.

7.1.1. CAGAs

Course area graduate attributes (CAGAs) are a set of statements giving the attributes that graduates from any course within the course area are deemed to have acquired. The system does not require this data to be completed, unless you want to ‘inherit’ the CGAs from the CAGAs. However, your faculty may require this data.

Update via CI/course area/Graduate Attributes/Edit

7.1.2. CGAs

Rather than having a set of generic graduate attributes that apply to all courses within the course area (i.e. CAGAs), each course, or sometimes groups of courses, can have their own set of course graduate attributes (i.e. CGAs). You need to complete this data to be able to add CILOs as CILOs sit under CGAs and use the CGA code as the first part of the CILO code, e.g. a CILO numbered ‘3.5’ is the fifth CILO linked to CGA 3.

Update via CI/course code/Graduate Attributes/Edit

7.1.3. CILOs

Course intended learning outcomes (CILOs) are learning outcomes associated with a specific course. CGAs need to have been completed before you can add the CILOs.

Update via CI/course code/Graduate Attributes/Intended learning outcomes

7.1.4. Parent study package

The parent study package is the course (or major) whose intended learning outcomes (CILOs) are linked to in the subject’s criteria linkages table (at Assessment Tasks / Edit #). The parent study package needs to be assigned before the criteria linkages can be fully completed.

Update via CI/subject code/Graduate Attributes/Parent study package

A course/major can be the parent for multiple subjects, indicated on the list of contributing study packages.

View via CI/parent study package code/Graduate Attributes/Contributing study packages

7.1.5. SLOs

Subject learning objectives (SLOs) are the specific learning objectives or outcomes of the subject, i.e. the professional, personal or academic knowledge, skills and values that students are expected to be able to demonstrate on completion of the subject.

Update via CI/subject code/Graduate Attributes/Learning objectives
7.1.6. CLTs
Criteria linkages are held in a criteria linkages table (CLT) in each assessment task, showing the assessment criteria and linking each criteria with the subject’s SLOs, and, where applicable, the parent course’s or study package’s CILOs. The CLT records the relative weighting that each criteria has in contributing to the mark awarded for the task as a whole.

Update via SO/subject code/Assessment Tasks/Edit #/Criteria linkages

7.2. Consequences of making changes
Because graduate attribute data is interrelated (i.e. linked), there are several important downstream consequences of editing or deleting course area graduate attributes (CAGAs), course graduate attributes (CGAs), course intended learning outcomes (CILOs), subject learning objectives (SLOs), or the parent study package.

The consequences can be minor or major, so before making changes to any GA data, you should ensure you know the ramifications of doing so. The following is a brief snapshot of the impacts, but full details are in the documentation.

7.2.1. CAGAs
You can make minor edits in CI to CAGA data, e.g. fix typos, add or remove words. However, there is no ongoing synchronisation between CAGAs and CGAs, so any changes to a CAGA will not automatically flow through to the CGA.

Deleting a CAGA cannot be undone. If there are courses whose graduate attributes were inherited from a set of CAGAs, deletion of one CAGA may require equivalent deletions in the set of CGAs of all affected courses.

7.2.2. CGAs
You can make minor edits in CI to CGA data, e.g. fix typos, add or remove words. However, there is no ongoing synchronisation between CGAs and CILOs, so any changes to a CGA will not automatically flow through to the CILO.

Deleting a CGA cannot be undone. If there are courses whose CILOs are linked to the CGA, deletion will disconnect the CILO, for example CILO 5.2 is linked to CGA 5; if you delete CGA 5, then CILO 5.2 is disconnected and ‘floating’ as CILO .2. The CILO will then need to be relinked to another CGA or deleted.

7.2.3. CILOs
You can make minor edits in CI to CILO data (description or short description), e.g. fix typos, add or remove words, without disconnecting the CILOs in the contributing study packages’ criteria linkage tables (CLTs) in SO. The dropdowns in the CLTs will automatically update with your amendments. If you add a new CILO, it will automatically appear on the dropdown list in the CLTs.

However, if you reorder the CILOs by changing the code numbers, you will need to check that the linkages in the CLTs are still correct.

If you delete an CILO you’ll get a warning message at the point of deletion advising you that this cannot be undone and there may be subject assessment criteria linked to this CILO which will be disconnected as a result of this deletion. You’ll also get a warning message above the CLTs. The old data will be displayed, but when you click into the CLT, the affected data will have disappeared and you’ll need to relink it.
7.2.4. **Parent study package**

If the parent study package is changed or deleted, all CILO links in the CLTs will be disconnected. This cannot be undone and re-adding the original deleted parent study package will not fix the problem.

If you need to change the parent study package (because, for example, the original parent is being phased out and a new parent with a new code is replacing it), all graduate attribute data should be copied from the soon-to-be phased out course into the new course. This will avoid disconnects in the criteria linkages tables of all the contributing study packages (i.e. the subjects that have the soon-to-be phased out course as their parent).

7.2.5. **SLOs**

You can make minor edits in CI to SLO data (description or short description), e.g. fix typos, add or remove words, without disconnecting the SLOs in the subject’s criteria linkage tables (CLTs) in SO. The dropdowns in the CLTs will automatically update with your amendments. If you add a new SLO, it will automatically appear on the dropdown list in the CLTs.

However, if you reorder the SLOs by changing the code numbers, you will need to check that the linkages in the CLTs are still correct.

If you delete an SLO you’ll get a warning message at the point of deletion advising you that this cannot be undone and there may be subject assessment criteria linked to this SLO which will be disconnected as a result of this deletion. You’ll also get a warning message above the CLTs. The old data will be displayed, but when you click into the CLT, the affected data will have disappeared and you’ll need to relink it.

7.2.6. **CLTs**

If you try to set up criteria linkages in the CLT before a parent study package has been specified, there will be no entries on the CILO drop-down menu.

If you try to set up criteria linkages in the CLT before SLOs have been specified, there will be no entries on the SLO drop-down menu.

7.3. **Display of GAs in subject outline PDFs**

See section 5. Subject Outline PDFs, specifically sub-sections 5.1.5. SLOs, 5.1.6. CILOs and 5.1.7. CLTs for details.

7.4. **GA reports**

APO CIS can generate and provide, on request, two graduate attribute reports.

Alternatively, CI Admin users can use the graduate attributes reporting function to create their own reports. The reporting function enables users to customise, run and store reports on any set of subjects, and to see how their associated GAs and CILOs are represented across the subjects’ assessment tasks.

Admin and other users with GA privileges are able to set up and edit reports; all users are able to run, view and download existing reports.
8. PUBLISHING DATA

8.1. UTS: Handbook

The handbook gets automatically republished every Sunday morning, unless it’s in the middle of handbook production, in which case auto-publishing is frozen. The freeze occurs around end-July to end September.

- Schedule
- Publishing criteria
- Course lifecycle diagram

If changes need to be published to the handbook sooner than Sunday, the pages can be manually generated by APO CIS. Email any requests.

8.2. CASS data → CIS

CASS data gets copied into CIS every night. Until CASS data is visible in CIS, it cannot be published to the handbook, UTS website, or anywhere else.

8.3. CIS data → UTS website

CIS (including CIS and CASS) data is copied to the UTS website every night and then released progressively throughout the next day. This means that a change made in CASS can take 48hrs to appear on the UTS website, e.g.

- Monday: change made in CASS
- Monday night: CASS data including the change copied into CIS
- Tuesday: CASS change visible in CIS
- Tuesday night: CIS data copied to the public website
- Wednesday: data released progressively to the UTS website

The copy of CIS data to the UTS website is temporarily frozen during the yearly data transition, which occurs in the week before Open Day, around the end of August.